
 About PowerCalc

What is PowerCalc?

PowerCalc is a powerful, 32 bit,Reverse Polish Notation (RPN)    desktop calculator that is designed to give 
you the power and flexibility you expect from a conventional calculator.    PowerCalc uses the power of RPN 
and a user-adjustable stack to combine the familiarity of standard windows controls with the power of a 
scientific calculator.

PowerCalc Features

PowerCalc has a number of distinguishing features that make it on of the most flexible and powerful 32 
bit windows desktops calculator out today.    Some of these features are:

· Fully Interactive Stack
· Full Cut and Paste Support for exchange with other applications
· Compact, low screen-space design.
· Customizable User Interface
· Full user variable    support
· Built in, commonly used functions 
· Convenient 10-key support and keyboard support
· Plentiful keyboard shortcuts
· Comprehensive help file.

    
Together, these features make PowerCalc easy to use and powerful enough for almost all the calculations 
you need from a desktop calculator.

Why should I register PowerCalc?

If you have the SHAREWARE version of PowerCalc, there are several reasons why you should register 
PowerCalc at or before the end of the 30 day trial:

· You will be obeying the law.    It is ILLEGAL to keep shareware after your trial period is over.
· You will encourage the author to make further changes and updates to PowerCalc, most of which

are FREE to registered users of PowerCalc.
· You will get rid of the annoying “nag” screen that comes up when PowerCalc starts up.
· Even if you don’t register, you will probably lose the 5 bucks in the couch anyway.

Please support the concept of shareware by following obeying the trial period, and registering PowerCalc 
if you use it past the trial period.

How do I register PowerCalc?

It is easy to register PowerCalc.    All you need to do is send payment for each copy of PowerCalc you 
would like to register, as well as your email address and/or snail-mail address, your name, and your 
phone number.    The cost of PowerCalc is $10 dollars (US Currency Only, please).    Send payments to:

David Cowden
4426 Congo Rd.

Benton, AR 72015



 When your payment is received, I will email you a username and password that will allow you to 
download the registered version of PowerCalc, and any updates, patches, etc. that I post as well.    If you 
prefer to have a copy of PowerCalc mailed to you via US Mail on floppy disks, include an additional $5 
with your payment.    See register.txt for an order form and more information.



 Using Reverse Polish Notation (RPN)
What is RPN?

Reverse Polish Notation (RPN) is a type of execution order in which operators come after the arguments.    RPN 
takes a little time to learn, but is generally faster to use once the user has become proficient.    RPN is 
particularly useful in scientific calculators, in which long, complex expressions are often evaluated.

How does RPN work?

Since RPN applies operators to the arguments after they have already been entered, RPN calculators need to 
have a means by which to store values to allow complex expressions to be evaluated.    This storage space is 
called the stack.    The stack is a Last in First Out structure, so that the values that you entered last are the first 
ones to be recalled.    To use RPN, you enter the values that you want to add, multiply, or work with.    They are 
entered onto the stack, and then you apply operators, which remove the values from the stack and return the 
result.    While at first this seems complicated, for larger expressions, the syntax actually makes a lot of sense, 
and has actually been proven to be faster and less error prone.

You never get anything for free, though, and the power and flexibility comes with a price: you have to practice 
using it to get used to “thinking ahead” to make things easy on yourself.    Using a conventional calculator is easy
because you can read the expression and key in the symbols from left to right (with a few exceptions).    You can 
do that with RPN too, but it will end up being more difficult than it needs to be.    Here are a few guidelines that 
will help get you started “thinking in RPN”

· Read the entire expression first, and note any parenthetical expressions.    Start entering expressions 
with the innermost expressions, and work on the same levels from left to right.

· Note any repeated values in the expression, and switch the order that you execute operations such 
that duplicates are entered together, so that you can just duplicate the entry instead of entering it 
again.

· Break very large expressions into parts that make sense to you:    these Intermediate values will be 
stored on the stack, and if you make a mistake later, you can just use the intermediate values 
without recalculating them if you can remember what they were.

Some examples of RPN in action.

The best way to learn RPN is just to play with it, so to speak.    Here are some case studies that will help you get 
started using RPN.    In the examples, <> indicate a button or key that should be pressed.

Example 1:    Adding two numbers
Expression: 2 + 3
Conventional Calculator:  <2> <+> <3> <=> 
RPN Implementation:    <2> <ENTER> <3> <+>

When you type the plus key (or press “+” on the calculator), the values 2 and 3 are removed from 
the stack, added, and then the result (in this case, 5) is returned to level 1 of the stack.    Most all 
operations will work in this manner.    Operators which require two arguments will take two values 
off the stack and return the result.    Operators that only require one argument will take one value 
from the stack, and then return the result to the stack.    (Such as COS, for example).

Example 2:    Taking the Cosine of a number
Expression: Cos(45)
Conventional Calcuator:    <4><5> <COS>
RPN : <4><5> <COS>

Since cosine requires only one argument, it is very similar to conventional notation.



Example 3:    A complex expression

Complex expressions are where RPN begins to show its power:

Expression: ((2 * Cos(45) + (1 + 6^2) )^1/2
Conventional Calculator

<(><(><2><*><4><5><cos><)><+><(><1><+><6><x^2><)><)><sqrt>

RPN <2><enter><4><5><cos><*><1><enter><6><x^2><+><+><sqrt>

This required only 13 button pushes, while the conventional required 17.    In addition, it    is less 
prone to error, since any mistake in the conventional expression would have required re-entering 
it, while the RPN can be corrected.    In general, expressions which contain parentheses are quicker 
and easier with RPN, since you will never need to push the ( buttons at all!

Example 4: Using the stack and rpn to simplify expressions
Expression:    2 * sqrt(2)
Conventional: <2><*><2><sqrt><=>
RPN: <2><ENTER><ENTER><sqrt><*>

IN this example, the fucntionality of the stack is used to avoid entering the number 2 twice, since 
pressing <ENTER> while a number is on the stack will result in the number being duplicated on the
stack again.    This wasn’t a big time saver here, since it would have been just as easy to press 2 as
Enter.    But take another case:

Example 5:    Simplifying expressions with redundant parts
Expression:        sqrt(776) * (1 + sqrt(776) )
Conventional: <7><7><6><sqrt><*><(><1><+><7><7><6><sqrt><)><=>
RPN: <7><7><6><sqrt><enter><1><+><*>

As you can see, since the number sqrt(776) was stored on the stack, we save time by not having to
enter the same expression again later.    We also save by not having the parenthesis.    In this 
example, RPN saved 6 button pushes:    the convetional expression took almost twice as many 
pushes!



The Stack
Description

The stack is a list of values which PowerCalc keeps in memory while calculations or other entries are 
being made.    Because PowerCalc Uses Reverse Polish Notation, the stack is necessary for completing 
operations.    The PowerCalc display shows the first 6 values of the stack, but the stack is actually much 
larger:    The default stack can hold up to 50 numbers, and you can customize it to hold as many as 1024 
numbers.

Structure
The stack is a Last in First Out structure, which means that as items are entered, they are put on the 
lowest level of the stack.    When an entry is added, all the other values in the stack move up one place to
make room for the new entry.    When operations use values from the stack, they take values from the 
lowest level.    To illustrate the way the stack functions, let’s take a simple example: adding two numbers.

When you add two numbers in RPN, the first number goes onto the stack.    Let’s say that number was 2.   
You enter that number by typing <2><enter>.    The enter key always enters a number that you have 
typed onto the stack.    To enter the second number on the stack, you would type <3><enter>.    The 3 
would be entered onto the first level, and the 2 would move up to the second level.    The stack would 
now look like this:

Level 2: 2
Level 1: 3

Next, you would invoke an operator, in this case the addition operator.    The addition operator requires 
two values, so when you type the <+> key, the addition operation takes the 3 from the lower level of the
stack, then takes the 2 from the stack(which is now in level 1 since the 3 was removed), and adds them 
together.    The addition operation will then put the result back onto the stack in level 1.    Any remaining 
entries are then pushed up to make room.

Let’s follow the stack’s values through an entire addition operation.    We’ll start with some other values 
on the stack to help illustrate how values move up and down when entries are added and removed.

Level 3: 8
Level 2: 8 2 8
Level1: 8 2 3 5
_______________________________________________________
State after Pressing: <2> <3> <+>

Stack Operations

To enter values onto the stack, you type the number (or variable, if they are stored- see variables) and 
then press or type enter, which enters the number(s) on the stack.    (PowerCalc also allows you to enter 
more than one number at a time by using spaces to separate your entries on the line:    For more 
information, see the Command Line)    After you have entered values, it is often necessary to change the 
position of one or more of the entries of the stack.    For example, you might want to add a number to 
another number that is up at level 5 in the stack, or you might want to add two numbers together which 
are both up high in the stack.    Since the operators all automatically take their arguments from the lowest
levels, you can’t just add them by pressing “+”.    Luckily, PowerCalc offers both conventional stack 
manipulation functions and an advanced, Interactive stack, which makes stack manipulation easy.

Standard Stack Manipulation Functions

PowerCalc provides several stack manipulation functions, which allows you to move numbers around on 
the stack.    They are not as powerful as the Interactive Stack features, but are more familiar to veteran 
RPN users.    You can get more detailed information about each function by going to the full description of 
the button or function.



<ENTER> Duplicates a stack entry
<drop> Removes a value from the lowest level of the stack.
<SWAP> interchanges the two lowest entries on the stack.

These functions allow simple control of the stack.    They are limited because the Interactive Stack (below)
allows much more flexibility.

The PowerCalc Interactive Stack

Because PowerCalc is a windows application, it has the benefit of the use of common windows controls, 
such as list boxes, to enhance the functionality of the stack.    IN most RPN calculators, complex stack 
manipulation commands are required, because you can’t access the stack values by reference: you must 
have the values at the lowest levels to operate on them.    PowerCalc, however, provides full support for 
operations on stack entries other the lowest levels.

Most of the commands in PowerCalc recognize when items in the stack are selected.    You can select one 
or more items in the stack by clicking in the stack window, and using the Control key to add non-adjacent
stack entries, or the shift key to select multiple stack values. (The stack is a standard windows list box, 
and functions in exactly the same way).    You can also highlight the entire stack by choosing SELECT ALL 
from the edit menu.

Once you have selected the items you would like, you can simply execute an operation.    PowerCalc uses 
the following rules to determine how to behave if items in the stack are selected:

If a unary operator is chosen, the operator is applied to all selected entries and the 
result is placed in the original location.    For example, if you used the change sign 
button with levels 3 and 2 selected, the following would result:

Level 3: 7 -7
Level 2: 4 -4
Level 1: 12.1 12.1

START RESULT

If a commutative operator is chosen, then PowerCalc applies the operator to all the 
selected entries together, and returns the result in level 1 of the stack.    The 
selected entries are removed from the stack.    For example, if you used the + key 
with levels 2 and 3 of the stack selected, the following would result:

Level4: 7
Level 3: 7 4
Level 2: 4 12.1
Level 1: 12.1 11

START RESULT

If swap is chosen, then PowerCalc will check the number of selected stack items.    If 
one item is selected, then it is swapped with the value in the first level. (Thus, for 
RPN users, you can ROLL the stack by selecting the highest values and swapping it). 
If two items are selected, they are interchanged.    If more than two items are 
selected, they are ignored and the two lowest values are reported, or an error occurs
if there are not enough values to do this.

If drop is chosen, then PowerCalc will drop all the selected entries from the stack.

If any other type of operator or function is chosen, PowerCalc will check to see if the 
number of selected items is equal to the number of arguments for the operation.    If 
so, the selected items will be used as arguments for the operation, in order from the 
top of the stack to the bottom.    If the number of arguments is not equal the number
required, the selected entries are ignored and the operation will be conducted as if 
nothing was selected.



Clipboard Support for the Stack:    Cutting and Pasting

PowerCalc has full support for the use of the Public Windows Clipboard.    You can use the copy and paste 
menu commands or keyboard shortcuts to copy the entire stack or selected stack values, and then paste 
them into other applications or onto PowerCalc’s Command Line.

When you copy items to the clipboard, PowerCalc separates the values with a delimiter, which is a space 
by default, but can be changed to other characters in the options screen (See Customizing PowerCalc).    
When the values are pasted back into PowerCalc or another application, the values that were copied are 
separated by the delimiter.    You can change the delimiter to allow you to paste data in the desired 
format into other applications.    For example, if you paste data into Microsoft Excel with spaces 
separating the values, they will appear as a row in excel.    If you change the delimiter to a newline 
character, however, they will be pasted as a column.

IMPORTANT NOTE:    If you intend to paste values into PowerCalc, use a space as the delimiter.    Other 
delimiters will result in an ‘invalid stack entry’ error.

Saving the stack between sessions:

You can save the values on the stack between sessions by checking the appropriate box in the options 
screen.    See customizing PowerCalc for more information

Manually Entering Saved Stack Data

If you ever would like to load data into PowerCalc, manually enter the data that PowerCalc has saved, or 
use the PowerCalc Stack data file for other applications, you can easily do so.    The data file that 
PowerCalc is called “stack.dat”, and can be found in the same directory as the PowerCalc executable.    
The file format is simple:    the first line of the data file contains the number of entries in the file, and then
the remainder of the file contains the values in the stack, each on its own line.    You can modify this file, 
import it into other applications, or export a similar file from other applications and use it when 
PowerCalc starts.    The number of entries in this file is limited to the maximum size of the stack itself:    
50 entries as a default, and up to 1024 if you customize it in the options screen.



Customizing PowerCalc
You can customize the operation and look of PowerCalc to suit your needs.    To show the options screen, choose 
Options from the Tools menu in the menu bar.    If the menu bar is not visible, then press the SHIFT key, and click 
the options button on the calculator.    Alternatively, you can press the F2 key, which will display the options 
screen as well.    You will see the PowerCalc Customization Screen, which will have the following areas:

On Exit

Prompt:    If checked, PowerCalc will ask if you really want to quit before exiting.    If not checked, 
PowerCalc will not ask for confirmation.

Save Stack Values:    If checked, PowerCalc will save the stack values in the file “Stack.dat”    If not, the 
file will not be modified on exit.

Save Settings:    If checked, PowerCalc will “remember” the current settings next session.    If not, the 
settings that were in affect at the beginning of the session will be used next time.

Save Variables:    If checked, PowerCalc will “remember” the names and values of any variables that you
have assigned, and automatically load them next session.    If not checked, variables will neither be 
saved or loaded the next session.

General
Beep on Errors:    If checked, PowerCalc will beep on all critical errors.    If not checked, PowerCalc will 

report errors in the status window, but will not beep.

Show menu bar:    If checked, the menu bar will appear at the top of PowerCalc.    If desktop space is 
critical, you can clear this box and the menu bar will not appear. You can also toggle this option using
the F6 key.

Show Stack Labels:    If checked, labels will appear at the left side of the stack, number them from 
bottom to top.    If cleared, they will not appear.    You can also toggle this option using the F7 key.

Startup
Display digits:    Determines the number of digits that are fixed on startup.    If 0 is selected, then all 

numbers are displayed to their actual precision, or 16 digits, which ever is shorter.    IF a number is 
selected from the list box, then all values in the stack will be truncated to that many digits to the 
right of the decimal point.

Angle Mode: Controls the default angle mode when PowerCalc starts.    Choose either Radians or 
Degrees

Stack Size
Controls the size of the stack (NOT the display height, which is always 6).    The default value is 50, which 
should be more than large enough for most calculations.    If more space is required, you can enter a 
positive number up to 1024, which is the largest stack size.    The smallest value the stack can be is 6.

Pasting and Exporting
The paste delimiter controls the character which is used to separate values when they are copied from 
the stack.    Use Space (the default) if you will be pasting into PowerCalc, or into rows of spreadsheets.    
Use ENTER if you will be pasting into columns, and use tab or comma if you application requires these 
characters as a delimiter.



 PowerCalc Variables
PowerCalc allows you to store and recall variables, so that you can assign commonly used values to meaningful 
names, and keep them in PowerCalc for use in later sessions.    The variables portion of PowerCalc can be shown 
by clicking the FCTN button on the right side of PowerCalc.    There you can find all of the controls that are 
required to store, remove, type, and recall variables.    You can also manually type variable names on the 
command line, and PowerCalc will substitute the correct values when the command line is processed (See the 
command line).    Each control and its function is listed below.

The variable list: Combo Box

The top most control is a combo box, which contains a list of all the variable that are currently defined.    
You can’t type in this box.    Use this box to select which variable the buttons below will perform their 
actions on.

Type

This button will type the name of the variable selected in the variable selection box on the command line.
If there is something already there, a space will be added so that the values will be processed separately 
when the command is entered.    You can type a variable more than once if you would like by pressing the
button.

Clear

Removes the selected variable from memory.    If you clear a variable, it will be permanently deleted.    

Enter

Enters the selected variable onto the stack.    This function differs from the Type button in that this will 
immediately enter the value onto the stack.    Any text on the command line will be processed before the 
variable is entered.

Store

Stores a variable in memory.    The store function requires two arguments: a valid value and a name.    To 
store a variable that is on the stack, type the desired name, and then press the store button.    You cannot
store a value in a variable name that already exists.    If you want to store a value in a variable that exists 
already, you must remove the first variable by selecting it in the list box and pressing the clear button.

Clear All

Clears all user variables from memory

Save to File

Saves the current variable list to the file “Vars.dat” in the PowerCalc directory.    Any existing variables 
and values there will be erased.    Use this button if you want to make sure that the current variable set is 
saved, or if you have set PowerCalc not to save variables on exit.    You cannot save variables to a file 
other than “Vars.dat”

Load from File

Loads variable list from the file “Vars.dat” in the PowerCalc directory.    Any existing variables and values 
will be erased or overwritten.    Use this button If you have set PowerCalc not to automatically save 
variables, or if you wish to manually reload the original variable list without restarting PowerCalc.    You 



cannot load variables from a file other than “Vars.dat”



Using the Keyboard
PowerCalc provides full keyboard support, so that it can be used quickly and easily.    PowerCalc allows the use of 
the 10-key numeric pad (make sure number lock is on), including the enter, +,-,*, and / keys there.    You can also
use the +,-,*,/,and number keys on the regular keyboard, for laptops or other keyboards that don’t have a 
numeric keypad.

PowerCalc also has a number of special keys, which are assigned to provide enhanced functionality and behave 
like other windows programs:

Special PowerCalc Keys
Keyboard
SHIFT Toggles 2nd function mode on and off
CTL+C Copy
CTL+V Paste
BKSPC Drop if no entries on command line, or backspace if there is text on the command line
ATL+?? Push button marked with underscore under a letter

Keypad Keys
PAGE UP show/hide variables and functions panel (same as pressing FCTN button)
PAGE DOWN show/hide options screen (same as pressing options button or chosing it from the 
menu)
HOME Undo/Redo:    Same as pressing the undo button
END Exit PowerCalc
INSERT Sign Change key (same as pressing +/- button)
DELETE Clear: same as pressing Clear button

Function Keys
F1 Display this help file
F2 Display the Options screen
F3 Clear Stack (same as pressing clear button)
F4 Show/Hide variables and functions panel (Toggle)
F5 Undo/Redo (same as pressing undo button)
F6 Hide/Show the menu bar (Toggle)
F7 Hide/Show stack labels (Toggle)
F10 Exit PowerCalc



Using the Command Line
The PowerCalc command line is designed to allow as much flexibility as possible when entering data.    Some of 
the primary features of the command line are:

Space delimiting
Separate any number of valid entries with a space (either by using the space bar or by using the space 
button on the calculator), and each entry will be entered on the stack individually for you.    Thus, instead 
of <2> <enter> <2> <+>, you can type <2> <spc> <2> <+>, and get the same thing.    Any invalid 
entries will be ignored, but the remaining, valid portions of the command line will be entered by 
themselves, and the invalid entry will be left on the command line for editing.

Variable substitution
You can use the name of any valid variable on the command line, and the proper value will be substituted
for you when the command line is evalutated.

Correction
You can use the backspace key (on the keyboard or on PowerCalc) to backup to correct entry mistakes.

Paste Support
You can use cut and paste support to copy values from the stack, and then paste them onto the 
command line in space delimited form. (See using the stack: cut and paste support).    You can also paste 
any space delimited set of values onto the command line, if you have copied values from another 
application.

AutoMatic Entry

You don’t have to manually press <ENTER> each time you finish the command line.    If you press a 
function or operator button, and there is something on the command line, PowerCalc will automatically 
assume that you want to first enter the value(s) on the command line, and then perform the requested 
operation.    Thus, if you want to add two numbers, you could merely enter <2> <spc> <2> <+>.    
PowerCalc will enter the two numbers separately on the stack (because of the space between them), and 
then perform the addiition.

Cautions when using the command line

· There are also some things that the command line will not allow, which are also important to know.    
Follow the following guidelines when using some of the advanced features of the commandl line:

· When entering negative numbers or numbers in scientific notion with negative exponents, use the sign 
change button and its corresponding shortcut key to enter the negative, not the - sign on the keyboard or
the keypad.    PowerCalc will interpret the “-“ as a request to enter the current command line on the stack 
and then perform a subtract operation



Button Descriptions
PowerCalc has a lot of buttons, and sometimes it isn’t at all obvious what they all do.    (That is one of the 
problems with a powerful, yet compact calculator like PowerCalc.)    This section contains a complete list of all of 
the buttons in PowerCalc, what they do, etc.

Display Control and Application Buttons

Button  (shortcut)                                     DESCRIPTION                                                         

FCTN (F4 and PAGEUP) Hides or shows the variables and functions panel.
EXIT (F10 and END) Exits PowerCalc
ABOUT F8 Displays Registration Information
CLEAR (F3 and DELETE) Clears the display
RAD/DEG Toggle between Degree and Radian Mode
OPTIONS (F2 and PAGEDOWN) (2nd mode only) Displays Options Panel
UNDO (F5 and HOME) Restores the stack before the last operation

FIX Fixes display to n digit precision.    0 sets to display the precision of 
the entire number. Argument must be an integer, or it is rounded to
an integer

Entry buttons
NUMBERS Enters number on command line
SPC Types a space on the command line
p Enters the number “pi” on the stack, and causes command line to be processed as well
+/- Changes the sign of either the number or of the exponent, if the entry is in scientific 

notation (SHORTCUT:    INSERT)
EEX types an “E” for scientific notation entries (you can use the keyboard e also)
<-- Backs up one character (also the backspace key)

Operators
-->RAD Converts to radians from degrees (1 argument)
-->DEG Converts to degrees from radians (1 argument)
x^2 Squares a number (1 argument)
sqrt Square Root (1 argument)
Ln natural log (1 argument)
Log Log base 10 (1 argument)
Y^X Y to the X power (2 arguments)
1/X Inverse (1 argument)
Sin Sin of a number (Note angle mode) (1 argument)
Cos Cos of a number (Note angle Mode) (1 argument)
Tan Tan of a number(Note angle mode) (1 argument)
+ Addition (2 arguments)
- Subtract (2 arguments)
/ Divide (2 arguments)
* Multiply (2 arguments)

2nd-function buttons
(access by pressing shift on keyboard or by choosing 2nd mode from menu)

e^x e to the x power(nat. antilog) (1 argument)



10^x 10 to the x power(antilog) (1 argument)
xrty xth root of y. (y to the 1/x power) (2 arguments)
asin arcsine (Note angle Mode) (1 argument)
acos arccosine (note angle mode) (1 argument)
atan arctangent(not angle mode) (1 argument)



Function Descriptions
PowerCalc has several built in engineering and statistical functions that are commonly useful when doing quick 
calculations.    Each function, its arguments, and its results are listed here.    In addition, most of these functions 
label the display with results, which show which result is what, since, several of the functions return more than 
one value.    The function buttons can be displayed by pressing the FCTN button at the top right of PowerCalc, or 
by using the Tools->Functions menu if the menu bar is visible.

Interpolate
Requires 5 arguments, and returns 1 result.    Arguments are two x,y points and one intermediate point, in
the form x1,y1,x2,y2,xmidde.    The resulting interpolated value ymiddle is returned in the first level of 
the stack.    Values can be either negative or positive, and can be any values, but the absolute value of 
x2-x1 must be greater than zero, I.E., the points cannot lie on a vertical line.

Average
Any number of arguments greater than 1.    Returns two results, which are labeled as “Total” and 
“Average”.    The total of the numbers and the average of the numbers are results.    The average is 
arithmetic, so the absolute values of the arguments are not taken (negative numbers will cancel postiive 
ones)

Quadratic
Requires 3 arguments, and returns 2 values.    The arguments are the coefficients of the 2nd order 
quadratic equation a*x^2 + b*x + c = 0.    The two real roots will be returned in the first two levels of the 
stack if the roots are real, or the fact that the roots are complex will be reported in the status line.    The 
values a, b, and c are taken in order from top to bottom.

-->Fraction
Requires 1 argument.    Converts any decimal number to its nearest fractional equivalent having a 
denominator equal to or less than 16.

Factorial (!)
Requires 1 integer argument.    Returns the factorial of the number.    If the argument is not an integer, it 
will truncated to the next lowest integer and then the factorial will be calculated.

Permutations (n[P])
Requires 2 integer arguments, where the first argument is larger than the second and both arguments 
are greater than zero.    Returns one value, the number of combinations of the second argument that can 
be made out of a group the size of the first argument, without regard to order

Combinations (n[C])
Requires 2 integer arguments, where the first argument is larger than the second and both arguments 
are greater than zero.    Returns one value, the number of combinations of the second argument that can 
be made out of a group the size of the first argument, with regard to order



Operators
A function or command which results in action on one or more arguments.    For example, the symbol '+' is 
usually the addition operator, which results in the addition of its two arguments, or the numbers to be added.    In
the expression 2 + 3 = 5, 2 and 3 are arguments, '+' is an operator, and 5 is the result.



Unary Operator
An operator which takes only one argument.    Examples of unary operators are the sign change key, trig 
functions, inverse, square, square root, and natural log.



Commutative Operator
A commutative operator is one which the order of the arguments doesn't make a difference in the result.    
Examples are additions and multiplication.    Since the order doesn't matter, a commutative operator can be 
applied to many numbers, since no matter what order they
are taken it, the result will be identical.



Last-in First-out (LIFO)
Describes the operation of a stack, in which values that are entered most recently are the first to be removed 
when the stack is read.    A LIFO stack operates much like cup dispenser: if you put take out a cup, the others all 
move down one cup.    If you place a cup back into the dispenser from the bottom, the other cups will all move 
up, and the cup you just put in will be the first cup removed when another person gets a cup later.



Menu Commands
Some of the commands that are available in PowerCalc, including all of the special functions and alternate 
screens, are available in the pull-down menus.    If the menu bar is not visible, you can display it by pressing the 
SHIFT key to activate second function mode, and then pressing the options button.

The File Menu Commands

About Shows the about screen, which shows registration information and information about 
the author.

Help Shows this file.

Exit Exits PowerCalc (same as pressing the exit button)

The Edit Menu

Select All Selects all of the entries in the stack
Copy Copies selected entries to the clipboard.
Paste Pastes the clipboard contents to the command line
Cut drops selected items from the stack , and copies them to the clipboard

The Tools Menu

Functions Shows a list of the available special functions.    Same as pressing the respective 
buttons

2nd function Toggles between 2nd and regular mode, displaying several different buttons on 
PowerCalc.

Options Displays the PowerCalc Options Screen




